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Title: Colorimetric Paper-based Detection of Escherichia coli, Salmonella spp., and Listeria monocytogenes from Large Volumes of Agricultural Water


Authors, please fill out the brief questionnaire below.   

A. Will you require assistance with video microscopy, such as filming a complex dissection or microinjection technique (Y/N, please specify steps by number. Also, please list make and model of your microscope)?  ___N_______
B.   Does your protocol include detailed, step-by-step, descriptions of software usage (Y/N, please specify steps by number)? ____Y_____
4.3.3
	4.3.3.1
	4.3.3.2
	4.3.3.3
	4.3.3.4
	4.3.3.5
	4.3.3.6

C.  Which steps of your protocol will viewers benefit most from having filmed? Please list 4-6 steps______
	1.2.1
	1.2.4
	2.1.1
	2.1.3
	4.1.1
	4.2.1

D.  What is the single most difficult aspect of this procedure and what do you do to ensure success?  5-Bromo-6-chloro-3-indolyl caprylate (magenta caprylate) is light sensitive and could potentially produce false positive results through autodegradation.  These issues are addressed by carefully protecting this substrate from light throughout the procedure, and by including proper controls, respectively.  

1. Introduction (Schematic Overview and Interview)
0. Schematic Overview (read by voice talent at JoVE):
0.1. The overall goal of this procedure is to detect foodborne pathogens in large volumes of agricultural water. (Intro)

0.2. To do this, a Modified Moore Swab, referred to hereafter as an MMS, is assembled by placing a folded piece of gauze or cheesecloth inside an MMS cassette.  (Top left)

0.3. Next, at the sampling site, target bacteria are concentrated by passing large volumes of water through the MMS using a peristaltic pump.  The ends of the MMS are then tightly capped and transported back to the lab.  (Top right)   

0.4. Selective or non-selective enrichment broth is added to the MMS, which is incubated for 18 hours.  (Middle right)     The enriched cultures are then collected, and, for E. coli detection, lysates are prepared.  (Middle left)

0.5. These are added to μPAD microspots impregnated with substrates for colorimetric enzymatic detection, and incubated for up to three hours. (Bottom right) 

0.6. The μPADs are then inspected and scanned.  Ultimately, visual and quantitative analysis of the microspots reveal the presence of E. coli, Salmonella spp., and L. monocytogenes at levels as low as 0.1 CFU/ml.    (Bottom Right) 





[image: ]


1. Interview: (Said by you on camera. Don’t forget to smile!)  

 
1.1. [Lawrence Goodridge] The main advantage of this technique over membrane filtration and culture on solid medium, is that larger volumes of water are sampled.   This increases the sensitivity of the assay and reduces the enrichment time and (ultimately the time to detection) to within 24 hours, as compared to 24 to 48 hours.

1.2. [Jaclyn Adkins]  In addition, the μPADs allow for simultaneous detection of three different foodborne pathogens, which cannot be detected using the same solid bacterial medium.   

1.3. [Bledar Bisha] The implications of this technique extend toward analysis of agricultural water and can be applied after extreme events such a wildfires or extreme rainfall events, both of which can lead to an increase in microbial contamination of surface water used for crop irrigation. 
1.3.1. Interview Style

1.4.  [Bledar Bisha]: We first had the idea for this method, when we needed to rapidly screen large volumes of river water for the presence of pathogens following the wildfires in Colorado during the summers of 2012 and 2013.  The method needed to be adaptable to use in the field due to the remote sampling areas, which made it difficult to collect and transport large volumes of water back to the lab for analysis.
1.4.1. Interview Style



Protocol (read by voice talent at JoVE):
2. Preparation of the Modified Moore Swab (MMS).
2.1. Begin this protocol by preparing a Modified Moore Swab, or MMS.  Cut a rectangular section of 4-ply cheesecloth measuring 40 × 12 cm. Fold the cheesecloth along both axes to obtain a rectangle of 20 × 6 cm.
2.1.1. MED:  Talent cutting a section of cheesecloth
2.1.2. CU:  Talent shows final piece and runs finger beside the 40 cm edge then the 12 cm edge (Editor, draw and arrow along each edge and label 40 cm and 12 cm)
2.1.3. CU:  Talent then folds the cheesecloth along both axes
  
2.2. Next, roll the cheesecloth tightly along its lengthier axis to form a cylindrical swab approximately 6 cm tall and 3 cm in diameter.  Insert the swab into the tin foil packet, and autoclave it for 15 minutes at 15 psi using a dry cycle.  (Text overlay:  see text for more information)
2.2.1. CU:  Talent rolls the cheesecloth and ties it with a ribbon of cheesecloth then shows it to the camera
2.2.1.1 CU: Talent wraps the rolled cheesecloth into a tinfoil packet
2.2.2. MED:  Talent places the cassette tin foil wrapped swab in the autoclave and closes the door
2.2.3. CU:  Talent inserts the autoclaved swab into the MMS cassette 
2.2.2.1 PU 

2.3. After autoclaving, the device is ready to be taken to the field.  Once on location, attach vinyl tubing to spigots on both sides of the MMS, ensuring the tubing fully adheres to the spigots.  Then, fix the tubing into the peristaltic pump.  Ensure that the tubing upstream of the peristaltic pump is of sufficient length for sampling.
2.3.1. CU:  Talent attaches vinyl tubing to spigots on both sides of the MSS then fixes tubing into the peristaltic pump
2.3.2. CU:  Talent shows the length of the tubing upstream of the peristaltic pump

3. Concentration of Bacteria from Large Volumes of Agricultural Water using MMS
3.1. To concentrate the bacteria, place the peristaltic pump inlet in the agricultural water to be sampled.   Run the peristaltic pump at a flow rate of 300ml/min and sample at least 10 L.
3.1.1. WIDE:  Talent places the end of tubing in the water sample
3.1.2. CU:  Talent starts the peristaltic pump

3.2. After sampling is complete, withdraw the peristaltic pump inlet from the water sample and continue running the pump until no effluent water is observed exiting the MMS.  (Text overlay: See text if using a manifold to run several samples simultaneously)
3.2.1. MED:  Talent withdraws pump inlet from water sample
3.2.2. CU:  Effluent water stops coming out of the MMS (action at end of take 2)

3.3. When concentration has been completed for all Modified Moore Swabs, carefully remove the vinyl tubing from the MMS spigots and cap the spigots on both sides of the MMS.
3.3.1. MED:  Talent removes the vinyl tubing from the MMS spigots 
3.3.2. CU:  Talent caps the spigots on both sides of the MMS

3.4. Store the tightly capped MMS for up to 12 hrs at refrigeration temperature before adding enrichment medium.
3.4.1. MED:  Talent places MMS in a cooler with ice packs and closes the lid.

4. MMS Enrichment and Sample Preparation
4.1. Here, enrichment of E. coli, Salmonella spp. and L. monocytogenes will be demonstrated.  One MMS is used for each selective enrichment. (Text overlay:  See text if non-disposable MMS cassette is used)
4.1.1. MED:  Talent unscrews the lid of the MMS
4.1.2. CU:  Talent adds 20 mL of the sterile enrichment broth
4.1.3. CU:  Show 3 MMS side by side and spread apart slightly – (if these can be labeled, please label them, if not, editor, please add text below them on screen to indicate “E. coli, Salmonella spp. and L. monocytogenes)
4.1.4. PU

4.2. Unscrew the lid of the MMS and, for enrichment of E. coli, add 20 ml of sterile buffered peptone water, or “BPW”, supplemented with 8 mg/L of vancomycin hydrochloride.  Screw the lid of the MMS back on tightly.  
4.2.1. CU:  Talent unscrews lid, adds to the E. coli MMS then screws lid back on
4.2.1.1 PU

4.3. For enrichment of Salmonella spp., add 20 ml of sterile BPW supplemented with 4 ml/L. Salmonella supplement. For enrichment of L. monocytogenes, add 20 ml of sterile VIDAS UP Listeria broth.  
4.3.1. CU:  Talent unscrews lid, adds to the Salmonella MMS then screws lid back on
4.3.1.1 PU
4.3.2. CU:  Talent unscrews lid, adds to the Listeria MMS, then screws lid back on
4.3.2.1 PU

4.4. Next, tightly wrap the spigots with Parafilm to avoid spills and possible contamination during enrichment.
4.4.1. CU:  Talent wraps the spigots with Parafilm

4.5. Incubate the MMS for 18 – 24 hours in a shaking incubator at 150 RPM.  (Text overlay: 42°C for E. coli and Salmonella spp., 30°C for L. monocytogenes,  or 37°C for non-selective enrichment.)
4.5.1. MED:  Talent places MMS in the incubator and turns on the shaker 
4.5.1.1 PU

4.6. When the incubation has completed, remove the MMS from the incubator, unscrew the lid, gently pour the media into a Falcon tube, and using a pipette, gently transfer 0.5 ml into a 1.5 ml microcentrifuge tube.  
4.6.1. MED:  Talent removes the MMS from the incubator
4.6.2. CU:  Talent uncaps one of the spigots unscrews the lid and then transfers 0.5 mL into a microcentrifuge tube the enriched media into a Falcon tube.
4.6.3. Talent transfers 0.5 mL of the enriched media into a microcentrifuge tube.

4.7. In preparation for colorimetric analysis of E. coli selective enrichment, or for the analysis of the non-selective enrichments, sonicate 0.5 ml of enrichment at 5 W, 22 kHz for 20 seconds using a probe sonicator. 
4.7.1. MED:  Talent sonicates the sample

5. Preparation and Embedding of Colorimetric Substrates in µPADs. 
5.1. Prepare stock solutions of the substrates CPRG, X-Gluc, magenta caprylate, and X-InP  in pH-adjusted HEPES buffer.  Protect the stock solutions from light.  (Text overlay: 3 mM CPRG, 62.5 mM X-Gluc, 15 mM magenta caprylate), 100 mM (X-InP). 
5.1.1. MED:  Talent prepares stock solutions
5.1.2. CU:  Talent wraps stock solution tubes in foil

5.2. 5-Bromo-6-chloro-3-indolyl caprylate, or “magenta caprylate”, is light sensitive and could potentially produce false positive results through autodegradation.  Be sure to carefully protect this substrate from light throughout the procedure.
5.2.1.  MED:  Finishes wrapping another stock solution tube in foil looks up at the camera, and says the above line Shows a shot of magenta caprylate being wrapped in tinfoil
5.2.1.1 PU

5.3. For each sample and target tested, place one µPAD inside a sterile Petri dish.   For E. coli detection, prepare CPRG and X-Gluc µPADs, for Salmonella spp. detection prepare magenta caprylate µPADs, and for L. monocytogenes detection prepare X-InP µPADs. 
5.3.1. :  Talent places the µPADs inside sterile Petri dishes
5.3.1.1 PU

5.4. Using a pipettor, embed the µPAD microspot with 24 µl of each substrate stock solution.
5.4.1. CU:  Talent pipettes substrate stock solution onto each microspot.

6. Detection and Data Analysis.
6.1. In preparation for detection, add 6 µl of the enriched sample to each appropriate µPAD. 
6.1.1. CU:  Talent adds enriched sample to each µPAD

6.2. Place the cover back on the Petri dish and seal it with Parafilm.  Incubate the sample with the µPAD at 37°C for up to 3 hours to allow for color development and drying of the microspots.
6.2.1. MED:  Talent puts covers on Petri dishes and seals with Parafilm
6.2.3.   MED:  Talent puts tin foil over Petri dish
6.2.2. MED:  Talent places Petri dishes in incubator

6.3. After the incubation, perform detection by simple visual inspection of the color changes of the µPADs.  Note that strong reactions, which produce definitive color changes, are typically expected following 18 -24 hr of enrichment.  These are considered positive, and do not require further clarification.
6.3.1. CU:  Talent inspects the micropads

6.4. If E. coli is present, microspots embedded with CPRG will change from yellow to red-violet, and microspots imbedded with X-Gluc will change from colorless to blue-green, as shown here.
6.4.1. LAB MEDIA:   51414_Goodridge_Ecoli_Before
6.4.2.  LAB MEDIA:  51414_Goodridge_Ecoli_After

6.5. If L. monocytogenes is present, microspots imbedded with X-InP will change from colorless to indigo. If Salmonella spp. are present, microspots embedded with magenta caprylate will change from colorless to purple-mauve. 
6.5.1. LAB MEDIA:  51414_Goodridge_Lmonocyotgenes_Before
6.5.2. LAB MEDIA:  51414_Goodridge_ Lmonocyotgenes_After
6.5.3. LAB MEDIA:  51414_Goodridge_Salmonella_Before
6.5.4. LAB MEDIA:  51414_Goodridge_Salmonella_After

6.6. In cases where the reactions are weakly positive, use software to facilitate a semi-quantitative analysis of the results.
6.6.1. LAB MEDIA:  51414_Goodridge_weakpositive 

6.7. To do this, allow the µPADs to fully dry.  Scan the µPAD using a flat-bed scanner.  Use ImageJ software to process the image.
6.7.1. MED:   Talent places µPAD on a flat-bed scanner
6.7.2. MEDOTS:  Talent uses ImageJ to process the image

6.8. Next, in ImageJ open the scanned image to be analyzed.  Then, to invert the image, click on the “Edit” tab on the main menu and select “Invert”.  
6.8.1. SCREEN:  Talent clicks on file, then open, and opens scanned image.  Talent then clicks on edit, then invert.

6.9. Use the “Analyze” tab on the main menu and select “Set Measurements” to select the reported measurements to analyze.
6.9.1. SCREEN:  Talent clicks on Analyze on the main menu, then selects “set measurements”

6.10. Make sure that the “Mean grey intensity,” “Limit to threshold,” and “Display label” boxes are checked, and press “OK.”  This sets how the software analyzes each area selected and how it reports it.
6.10.1. SCREEN:  Talent checks the “Mean grey intensity,” “Limit to threshold,” and “Display label” boxes

6.11. Next, using the “Oval” tool, outline the area to be analyzed. 
6.11.1. SCREEN:  Talent selects the oval tool and draws a circle around the area to be analyzed.

6.12. Under the “Analyze” tab, select “Measure.” The software will measure the average grey intensity within the area defined and report it in a pop-up screen that can be copied and pasted to Excel for further analysis.  (Text overlay: Note: For more accurate analyses, at least two technical replicates of each sample should be performed.)
6.12.1. SCREEN:  Talent clicks on analyze, then measure.  

7. Examples of Colorimetric Detection of Escherichia coli, Salmonella spp., and Listeria monocytogenes:
7.1.  µPAD assays are based on the detection of bacteria-indicative enzymes which react with colorimetric substrates.
7.1.1. 51414_Goodridge_Figure 2A  

7.2. Assays detecting E. coli produce a blue-green product and a red-violet product.
7.2.1. 51414_Goodridge_Figure 2A  
7.2.2. 51414_Goodridge_Figure 2B  

7.3. Assays detecting Salmonella spp. (Figure 2C), and L. monocytogenes (Figure 2D) produce purple-mauve and indigo colors, respectively.
7.3.1. 51414_Goodridge_Figure 2C  
7.3.2. 51414_Goodridge_Figure 2D 

7.4. Alternatively, digitized images can be manipulated using ImageJ software (Figure 3A) to allow for more objective and standardized data interpretation.
7.4.1. 51414_Goodridge_Figure 3A

7.5. Here, digitized colorimetric images for each assay with both a negative and positive test are shown.  Negative tests were performed using bacterial species that do not encode the target enzymes and positive tests were performed with target bacteria.  
7.5.1. LAB MEDIA:  51414_Goodridge_Figure3A (Editor, please highlight the row as it is mentioned)

7.6. The first row shows unmodified scanned images.  In row 2, the scanned images have been converted to greyscale using ImageJ software, and in row 3, the color has been inverted for subsequent interpretation of grey intensity.  
7.6.1. LAB MEDIA:  51414_Goodridge_Figure3A (Editor, please highlight the row as it is mentioned)

7.7. Row four shows the average grey intensity measured using ImageJ within each microspot of the µPAD.  An example microspot is indicated by the yellow arrow and circle.  
7.7.1. LAB MEDIA:  51414_Goodridge_Figure3A (Editor, please highlight the row as it is mentioned)

7.8. This graph shows the average grey intensities from 4 replicates, determined by ImageJ, for each colorimetric µPAD positive and negative test.
7.8.1. LAB MEDIA:  51414_Goodridge_Figure3B
 
7.9. These data demonstrate that unambiguous detection of the three target microorganisms concentrated from large volumes of agricultural water can be performed via this procedure.
7.9.1. LAB MEDIA:  51414_Goodridge_Figure3B
 


Conclusion (said by authors on camera)
5.1. [Bledar Bisha]: After watching this video, you should have a good understanding of how to assemble a MMS, concentrate microorganisms of interest from large volumes of agricultural water, as well as perform colorimetric enzymatic detection and analysis on paper-based analytical devices.
5.1.1. Interview Style

5.2. [Jaclyn Adkins]: While attempting this procedure, it’s important to remember to include a sonication step for detection of E. coli, and to protect the magenta caprylate substrate from light as much as possible.  Correct assembly and of the MMS and proper sealing prior to incubation is crucial for successful completion of the procedure.
5.2.1. Interview Style
[bookmark: _GoBack]
5.3. [Jaclyn Adkins]:  With additional development, this technique promises to become very useful as a simple, inexpensive and rapid approach to point-of-need diagnostics for microbial pathogens and indicator microorganisms.  Beyond food safety applications, this technique can find potential use in environmental and clinical microbiology.
5.3.1. Interview Style

5.4. [Lawrence Goodridge]: Don't forget that working with pathogenic microorganisms can be extremely hazardous and it is important to avoid spilling of enrichments and formation of aerosols.  These precautions should always be taken while performing this procedure. 
5.4.1. Interview Style  


Provided Media
51414_Goodridge_SchematicOverview
51414_Goodridge_Ecoli_Before
51414_Goodridge_Ecoli_After
51414_Goodridge_Lmonocyotgenes_Before
51414_Goodridge_ Lmonocyotgenes_After
51414_Goodridge_Salmonella_Before
51414_Goodridge_Salmonella_After 51414_Goodridge_weakpositive 
51414_Goodridge_Figure 2A  
51414_Goodridge_Figure 2B
51414_Goodridge_Figure 2C  
51414_Goodridge_Figure 2D  
51414_Goodridge_Figure 3A  
51414_Goodridge_Figure 3B


General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.
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